
USER GUIDE

MADCAP FLARE DESKTOP 2025

Topics



Copyright © 2025 MadCap Software. All rights reserved.

Information in this document is subject to change without notice. The software described in this document is furnished
under a license agreement or nondisclosure agreement. The software may be used or copied only in accordance with the
terms of those agreements. No part of this publication may be reproduced, stored in a retrieval system, or transmitted in
any form or any means electronic or mechanical, including photocopying and recording for any purpose other than the
purchaser's personal use without the written permission of MadCap Software.

MadCap Software
1660 17th Street, Suite 201
Denver, Colorado 80202
858-320-0387
www.madcapsoftware.com

THIS PDF WAS CREATED USING MADCAP FLARE.



CONTENTS

CHAPTER 1

Introduction 5

CHAPTER 2

General Information for Topics 8
Topic-Based Authoring 9
Size of Topics 11
Topic Content 12
Getting Behind the Scenes of Topics 13
Special Topics 13
Layout Modes 14

CHAPTER 3

Main Activities for Topics 30
Creating Topics 31
Importing Topics 34
Opening Topics 36
Previewing Topics 40
Analyzing Topics 51
Reviewing Topics 57

CONTENTS iii



CHAPTER 4

Other Activities for Topics 79
Closing Topics 80
Creating New Topics From the TOC Editor 82
Deleting Topics 84
Setting the Default Paste Behavior 85
Pasting Text From Other Programs 86
Printing Topics 89
Renaming Topics 89
Including or Excluding Topics in Search 90
Specifying the Startup Topic in a Target 91
Print-Based Topics 92
Changing Topic Titles 102
XML Editor 105

APPENDIX

PDFs 122
Tutorials 122
Cheat Sheets 123
User Guides 124

CONTENTS iv



CHAPTER 1

Introduction
A topic is a file containing information about a particular subject. Topics might be the most
important part of a project. Everything else is contained within topics (e.g., cross-references, text,
images) or points toward topics (e.g., tables of contents). The very reason end users open a Help
system or manual is to find information, a little direction. They find that help within individual
topics.
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General Information

n "Topic-Based Authoring" on page 9

n "Size of Topics" on page 11

n "Topic Content" on page 12

n "Getting Behind the Scenes of Topics" on page 13

n "Special Topics" on page 13

n "Layout Modes" on page 14

Main Activities

n "Creating Topics" on page 31

n "Importing Topics" on page 34

n "Opening Topics" on page 36

n "Previewing Topics" on page 40

n "Analyzing Topics" on page 51

n "Reviewing Topics" on page 57
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Other Activities

n "Closing Topics" on page 80

n "Creating New Topics From the TOC Editor" on page 82

n "Deleting Topics" on page 84

n "Setting the Default Paste Behavior" on page 85

n "Pasting Text From Other Programs" on page 86

n "Printing Topics" on page 89

n "Renaming Topics" on page 89

n "Including or Excluding Topics in Search" on page 90

n "Specifying the Startup Topic in a Target" on page 91

n "Print-Based Topics" on page 92

n "XML Editor" on page 105
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CHAPTER 2

General Information for Topics
There are various pieces of general information you should know if you plan to use this feature.

This chapter discusses the following:

Topic-Based Authoring 9

Size of Topics 11

Topic Content 12

Getting Behind the Scenes of Topics 13

Special Topics 13

Layout Modes 14
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Topic-Based Authoring
Each topic is a separate XHTML file with an .htm extension. This enables you to take advantage of
topic-based authoring. In other words, rather than creating a few very long documents (as you
might do when working in a program such as Adobe FrameMaker or Microsoft Word), you create
many small documents and then piece those separate files together to produce various outputs.

Individual topic files are stored in the Content Explorer, either at the root level or in custom folders
that you create.
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In your Flare project folder (you specified the location for the folder on your computer when you
created the project), the topic files are stored in a subfolder called "Content."
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Size of Topics
It's important to keep the size of your topics in mind when you are creating and editing them.

For online output, topics are like pages on a well-designed website. They should not be too long, but
should be long enough to provide useful information. There is no specific rule for determining how
long to make your topics. It is mostly a matter of common sense. When you are developing a topic,
ask yourself if it is something that you would find useful and easy to read.

For print-based output, topics can be strung together in the output to form larger chapters. It is
recommended that you try to use relatively small topics when working in Flare Desktop—usually no
more than a few pages in output. Although you can certainly create a very long topic that holds all
of the content for an entire chapter or manual, smaller topics allow you to take full advantage of
Flare Desktop's many powerful single-sourcing features. For example, with small topics, you can
reuse them when generating many different outputs, all from the same project. You might want to
use some topics in some outputs, but not in others. With large documents, that is very difficult, if
not impossible to do.

Another reason to keep your topics (and snippets) relatively short has to do with reviews, especially
in MadCap Flare Online. If your file size is too large, it won't load in the Flare Online review editor.

If you have topics that seem to be too long, here are some suggestions:

n Break the topic into smaller topics and provide hyperlinks from one topic to another.
Understand how topic-based authoring and single-sourcing work.

n If you are importing files into a project, make sure you choose settings to break the files into
multiple topics according to heading levels.

n You can use Flare Desktop's DHTML features (drop-down text and expanding text) to
collapse areas of text until end users click a hotspot to open the hidden text.
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Topic Content
After you create a topic, you can add to it almost anything you want—text, tables, formatting, cross-
references, images, multimedia, etc. It all depends on the needs of your audience. A topic can
contain simple text, or it can contain a combination of many elements. A topic does not even need
to contain much text at all; for example, you could simply use a topic to hold a video for online
output or a few lines of text for the title page in print-based output. You are only limited by what you
can do with XML.

If you are not familiar with XML, that's okay. You can use the easy editor interface to edit topics in
Flare Desktop, working much like you would in a program such as Microsoft Word. Flare Desktop
creates the XML tags behind the scenes for you.

CHAPTER 2  12



Getting Behind the Scenes of Topics
Although Flare Desktop provides you with a user interface to work on topics (i.e., the XML Editor),
you can get behind the scenes to see and edit the code for the topic. The easiest way to do this is to
open the topic in the Internal Text Editor in Flare Desktop. To do this, open the topic as usual, then
at the bottom of the XML Editor, click the Text Editor tab. You can also use split the editor between
the XML Editor and the Internal Text Editor.

NOTE Although it is possible to open any Flare files in a third-party editor, it is
recommended that you avoid editing these files in certain programs while Flare Desktop is
running. For example, opening a stylesheet in Notepad++ is not an issue. But you might
experience problems if you open a topic or snippet in Microsoft Word and edit it while Flare
Desktop is running.

Special Topics
In addition to the regular topics that make up your chapter content, you can create special topics
with a proxy (placeholder) for displaying generated content. These special topics are often used for
your manual's front matter and back matter. The most common type of generated content is a
table of contents. Other kinds of output for which you can create topics include indexes, glossaries,
endnotes, lists of elements, and lists of concepts.
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Layout Modes
Flare Desktop provides multiple layout modes when working in the XML Editor: Web Layout, Web
Layout (Tablet), Web Layout (Mobile), and Print Layout. This lets you see your content in the format
that you are most likely concerned about at the moment.

n Web Layout Mode The Web Layout Mode is useful for seeing how the topic will look online,
usually on a laptop or a large monitor.

n Web Layout (Tablet) Mode The Web Layout (Tablet) Mode is useful for seeing how the topic
will look on a tablet device.

n Web Layout (Mobile) Mode The Web Layout (Mobile) Mode is useful for seeing how the topic
will look on a mobile device.
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n Print Layout Mode The Print Layout mode lets you see how the pages will look with a page
layout applied to it. In other words, it lets you see how the page will look when you generate
print-based output. This means that you will be able to view the actual page size and
orientation, as well as the margins and any header or footer content.

NOTE Although the Print Layout mode is a WYSIWYG (What You See Is What You
Get) environment, you also need to consider any condition tags when you are viewing
pages in this mode. For example, let's say you have applied a condition tag to an
entire paragraph on a page. When you are viewing the topic in the XML Editor, you will
see this paragraph, but if you generate a target where you have elected to exclude
that condition tag, the paragraph will not be displayed in the output, and the other
paragraphs will shift to compensate for its absence. Therefore, what you see in the
Print Layout mode is what you get, except possibly for certain conditions that may be
present on a page.

You can get an even more accurate look at how a topic will look in the output by
associating conditions with it while you are editing. This is similar to the feature that
you can use to preview a document with certain conditions set. The difference is that
this associates the conditions to the document as you edit it in the XML Editor.

n Edit Page Layout Document This opens the page layout associated with the topic so that you
can edit it in the Page Layout Editor.

n Edit Primary Stylesheet This opens the stylesheet associated with the topic so that you can
edit it in the Stylesheet Editor.

NOTE This option is available only if you have applied a primary stylesheet to the
project or target.

CHAPTER 2  15



Layout Modes, Mediums, and Media Queries
You can toggle between the various layout modes in the XML Editor by clicking the Layout Mode
button.

The default and print mediums are tied to the Web Layout and Print Layout modes, respectively.
The tablet and mobile media queries are tied to the Web Layout (Tablet) and Web Layout (Mobile)
modes, respectively. However, you can choose any stylesheet medium or media query when you
are in a particular layout mode to show the content with certain styles applied.

Keep in mind that the tablet and mobile media queries are associated with your responsive skin
settings on the Skin tab of HTML5 targets. This means that the Web Layout (Tablet) and Web
Layout (Mobile) modes will show content in the XML Editor at the maximum width that is set for
each in the Target Editor. Therefore, when viewing content in one of those modes, you might see a
horizontal scroll bar at the bottom of the editor. If you adjust the breakpoints for these media
queries in the Target Editor, the XML Editor will respond accordingly.

NOTE The Medium drop-down shows all the medium styles that are in effect in the editor.
For example, if the mobile layout is displayed, both the mobile and tablet medium styles
apply and are selected. If (multiple) is displayed in the Medium drop-down, that is an
indication that multiple styles are applied. Content in the editor is rendered with all
applicable styles (according to the width).

NOTE If you select from the Medium drop-down a medium other than the default, then the
Medium (default) label changes to Reset to Default Medium. If you click to reset, the label
goes back to Default Medium with a check mark to show it is selected.

NOTE You can view multiple mediums at once in the editor. If you switch the layout mode,
the medium changes automatically. But, you can experiment in the editor to see how
different mediums and media queries might look together by toggling those items on and
off in the Medium drop-down.
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EXAMPLE You are using the Web Layout mode. Therefore, the XML Editor displays the
styles specified in the default medium. A topic might look like this:
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But if you switch to Print Layout mode, the XML Editor automatically displays the styles
specified in the print medium. It might look like this:
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If you choose the Web Layout (Tablet) mode, you'll notice that the topic looks similar to the
regular Web Layout mode, except the content is shown at the maximum width of your
tablet settings.
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And if you choose the Web Layout (Mobile) mode, the content will be narrower. The XML
Editor adjusts to show the topic as if it were displayed on a mobile device. The Medium
drop-down displays as (multiple) when multiple styles are applied. When the layout is in
mobile mode, both the mobile and tablet mediums are applicable.
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Suppose you want to reduce the width of the tablet and mobile media queries. In that case,
you open your HTML5 target and change the breakpoints, perhaps to something like this:
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Now when you go back to the XML Editor and view the topic in Web Layout (Tablet) mode,
it will look like this:
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And in Web Layout (Mobile) mode, it will look like this:
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General Guidelines
The layout mode and the medium that you should use when editing in the XML Editor depends on
what you are trying to accomplish. Do you have web output for a large monitor in mind while you
are editing, are you trying to edit for smaller devices, or are you thinking more about print output?
Following are some general guidelines, but they may vary depending on the mediums or media
queries that you might have created and will be using for your different targets.

n If Editing with Online Output in Mind For best results, in the local toolbar of the XML Editor,
select the Web Layout mode and the default medium:

n If Editing with Tablet Output in Mind For best results, in the local toolbar of the XML Editor,
select the Web Layout (Tablet) mode and the tablet media query:

n If Editing with Mobile Output in Mind For best results, in the local toolbar of the XML Editor,
select the Web Layout (Mobile) mode and the mobile media query:

n If Editing with Print Output in Mind For best results, in the local toolbar of the XML Editor,
select the Print Layout mode and the print medium:
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Also, if you are viewing content using the Print Layout in the XML Editor, you can use another
drop-down in the local toolbar to choose a specific page layout.

For example, if you know you are looking at a topic that will end up being the first page of a
new chapter, you can select the Page Layout drop-down, choose the appropriate page layout,
and then select First Right. Or if you know it will be on a subsequent page of the chapter, you
might select Left or Right.

So if the topic looks kind of unusual when you first open it, that may be due to the fact that the
proper layout mode, page type, and/or medium is not selected in the local toolbar.

Is It WYSIWYG?
Is the XML Editor a WYSIWYG (What You See Is What You Get) environment? The answer to that
depends to a certain extent on the layout mode.

When using one of the Web Layout modes and the corresponding medium or media query (default,
tablet, mobile), the topics should look pretty close in the XML Editor to how they will be displayed in
the online output. For the Print Layout mode and print medium, it's a bit of a different story. The
main reason is that online output is designed to have many independent pages, whereas print
output is intended to be read one page after the other in one long document. Flare Desktop has no
way of knowing exactly where a particular topic will land in a PDF until you actually generate it.
However, by selecting the appropriate layout mode, page layout, and page type, you can get
relatively close.
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Conditions While Editing
Conditions on content also affect whether you are seeing true WYSIWYG. If you have sections of
content that are conditioned for one kind of output and other sections conditioned for a different
output, that's not an accurate picture of what you will see when you view a generated target.
However, there is something you can do about this.

While working in the XML Editor, you can show or hide different conditions in the topic. This lets you
see only the content that is intended for a particular output that you want to produce.

To do this, in the local toolbar of the XML Editor click and in the Target Expressions drop-down
field, choose one of your targets. The content in the XML Editor changes to include only the
conditions for that target.

Doing this doesn't affect the output at all. It's simply a way to see how a particular topic will look in
a specific output without building or previewing it. You can always repeat these steps to return the
topic to its previous state in the XML Editor or to see how it looks with a different target selected.

Opening Page Layouts
If you double-click on a topic page in Print Layout mode (outside the flow of the main body text), the
associated page layout will open in the Page Layout Editor.
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Pages
As you add more and more content to the topic, pages are added below. A navigation toolbar at the
bottom of the editor lets you see how many pages are in the topic and quickly navigate to any of
them as necessary.
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If you are using the Print Layout view in the XML Editor and the topic contains more than one page
of content, a label appears beside the scroll bar indicating the current page.
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What’s Noteworthy?

NOTE If you are incorporating elements in a topic with absolute positioning, you should be
aware of the layout mode as you are editing. This is due to the fact that online and print
outputs react differently to absolute positioning. Also, the option to wrap text all around an
element is supported only in print outputs.

NOTE Different operating systems render text differently in the XML Editor. Therefore, if
you and another author are looking at the same topic from the same project, but you have
different operating systems, the topic may look differently for you than it does for the other
person.

NOTE If you set a table to a specific height, that height may not be represented accurately
if you are viewing the topic in Print Layout mode.

NOTE If you have the layout resizer enabled and you select a layout mode from the top of
the editor, a thumb marker moves to the selected layout width and content is resized to
that width.
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CHAPTER 3

Main Activities for Topics
Some activities are particularly common and important when it comes to this feature.

This chapter discusses the following:

Creating Topics 31

Importing Topics 34

Opening Topics 36

Previewing Topics 40

Analyzing Topics 51

Reviewing Topics 57
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Creating Topics
Use the following steps to create a new topic using the Add File dialog.

How to Create a Topic
1. In the Content Explorer, right-click on a folder and from the context menu select New > Topic.

TIP When adding a new file to the Content Explorer, the recommended method is to
right-click on the folder in the Content Explorer and use the New menu option. This is
the most efficient way to direct the new file to the folder where you want to store it.
That's because the Add File dialog opens when you add a new content file, and this
method ensures that the folder you want is already selected in that dialog.

OTHER OPTIONS
n Ribbon Open the Project ribbon and select New > Topic.

n Local Toolbar In the local toolbar of the Content Explorer click .

n Keyboard Shortcut Press CTRL+T.

2. Select a template.

n New From Template Choose either a factory template file or one of your own custom
template files as a starting point. The new file will take on all of the settings contained
in the template. If you want to use the factory template provided by Flare Desktop,
expand the Factory Templates folder and click on a template file. If you want to use
your own custom template file, expand the appropriate folder and click on a file. For
more information about templates, see the Help system.

l NewTopic.htm This creates a regular topic with default text that you can replace.
This is the template that you will select most of the time.

l TopicForEndnotes.htm This creates a topic with an Endnotes proxy, which can be
used to generate a list of all your end notes (footnotes) when you build print-based
output.
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l TopicForGlossary.htm This creates a topic with a Glossary proxy, which can be used
to generate a list of all your glossary terms and definitions when you build print-
based output.

l TopicForIndex.htm This creates a topic with an Index proxy, which can be used to
generate an index when you build print-based output.

l TopicForListOfConcepts.htm This creates a topic with a Concepts proxy, which can
be used to generate a list of all your concept keywords when you build print-based
output.

l TopicForListOfElements.htm This creates a topic with a List-Of proxy, which can be
used to generate a list of any kind of element you want when you build print-based
output.

l TopicForListOfImages.htm This creates a topic with a List-Of proxy, which can be
used to generate a list of all of your images when you build print-based output.

l TopicForListOfTables.htm This creates a topic with a List-Of proxy, which can be
used to generate a list of all of your tables when you build print-based output.

l TopicForMiniTOC.htm This creates a topic with a mini-toc proxy, which can be used
to generate a small table of contents when you build online or print-based output.

l TopicForTOC.htm This creates a topic with a TOC proxy, which can be used to
generate a full table of contents when you build print-based output.

n New From Existing Choose an existing file of the same type as a starting point for your
new file. As with template files, your new file will take on all of the settings contained in
the file you select. To use this option, click , use the Open File dialog to find a file, and
double-click it.
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3. In the File Name field type a new name for the topic.

(Optional) The Folder field is automatically populated with the folder that has focus in the
Content Explorer. If you want to place the file into a folder that you previously created in the
Content Explorer, in the Folder field click and select the subfolder. Otherwise, keep the
default location.

NOTE Spaces are allowed in the file name. However, if you are publishing output to a
UNIX system, avoiding spaces in the file name is recommended. You can use
underscores in place of spaces.

4. (Optional) You can complete additional fields at the bottom of the dialog.

n 1st Heading If you want the heading for the topic to use the same text that you provide
for the file name, leave this field blank. Otherwise, enter the text that you want to use
for the heading in the topic.

n Title You can give the topic a title for the file. This does not refer to the visual title (or
heading) at the top of the topic. Rather, it refers to the properties title for the topic (). If
you leave this field blank, the text from the “1st Heading” field will be used for the title.

n Stylesheet Select a stylesheet to associate with the new topic. If you do not have a
stylesheet in your project, this field remains blank. This field is disabled if you have
applied a primary stylesheet.

n Style If you want the heading for the topic to use the default h1 style, leave this field
blank. Otherwise, select a style to apply to the heading in the topic.

n Condition Tags If you want to apply condition tags to the file, expand the Attributes
section at the bottom of the dialog. Next to the Condition Tags field, click and select
the conditions you want to apply. Click OK.

n File Tags If you want to apply file tags, expand the Attributes section at the bottom of
the dialog. Next to the File Tags field, click and select the file tags you want to apply.
Click OK.

5. Click Add.
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Importing Topics
You can import individual XHTML files (such as those from another Flare project).

How to Import a Topic
1. In the Content Explorer, right-click on a folder and from the context menu select New > Topic.

TIP When adding a new file to the Content Explorer, the recommended method is to
right-click on the folder in the Content Explorer and use the New menu option. This is
the most efficient way to direct the new file to the folder where you want to store it.
That's because the Add File dialog opens when you add a new content file, and this
method ensures that the folder you want is already selected in that dialog.

OTHER OPTIONS
n Ribbon Open the Project ribbon and select New > Topic.

n Local Toolbar In the local toolbar of the Content Explorer click .

n Keyboard Shortcut Press CTRL+T.

2. Select New from existing and click .

3. In the Open dialog, navigate to the XHTML file that you want to import. Then select it and
click Open. The Source File field now contains the path to the file that you are importing. Also,
the name of the file is displayed in the File Name field.

4. (Optional) The Folder field is automatically populated with the folder that has focus in the
Content Explorer. If you want to place the file into a folder that you previously created in the
Content Explorer, in the Folder field click and select the subfolder. Otherwise, keep the
default location.

5. (Optional) If you want to give the topic a different name than that for the imported file, click in
the File name field and enter the text.
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6. (Optional) If you want the heading for the topic to use the same text that you provide for the
file name, leave the 1st Heading field blank. Otherwise, enter the text that you want to use for
the heading in the topic.

7. (Optional) If you want the heading for the topic to use the default h1 style, leave the Style field
blank. Otherwise, select a style to apply to the heading in the topic.

8. (Optional) In the Stylesheet field, select a stylesheet to apply to the new topic. If you do not
have a stylesheet in your project, this field remains blank.

9. (Optional) If you want to apply condition tags to the file, expand the Attributes section at the
bottom of the dialog. Next to the Condition Tags field, click and select the conditions you
want to apply. Click OK.

10. (Optional) If you want to apply file tags, expand the Attributes section at the bottom of the
dialog. Next to the File Tags field, click and select the file tags you want to apply. Click OK.

11. Click Add. The topic is added and opens in the XML Editor.

NOTE You can also import plain HTML files, automatically converting them to XHTML files.
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Opening Topics
After you create topics, they are stored in the Content Explorer. You can open as many existing
topics as you want at one time. Each topic displays in its own page of the XML Editor and remains
accessible as you work. As you open more topics or other elements (e.g., targets, tables of
contents, stylesheets), each page displays in the appropriate editor (e.g., XML Editor, Target Editor,
TOC Editor, Stylesheet Editor). By default, the most recently opened page tab is on the left side of
the editor section in Flare Desktop, and the tabs for the previously opened pages shift to the right.
The active page displays on top of the other pages, and you can make any page the active one (or
"the one on top") by simply clicking its tab.

You can open topics the traditional way, from inside the interface. But you can also open them by
dragging topic files from a Windows folder.
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How to Open a Topic From the Quick Launch
Bar
The Quick Launch bar lets you search for any Flare Desktop file or command. It is located in the
upper-right corner of the interface. You can press CTRL+Q on your keyboard to move focus to the
Quick Launch bar so you can begin typing.

1. In the Quick Launch bar, type a few letters of the name of the file you want to open. Any
available results appear in a drop-down list.

2. From the list, click the name of the file.
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How to Open a Topic From the Content Explorer
1. Open the Content Explorer.

2. All of your topics are displayed under the Content folder (or under subfolders that you have
created previously when organizing your topics). Locate the file that you want to open. You
can use the "multi-view" to do this.

Option Description

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the "Show Folders"
button is selected, the area splits into two halves. The folder is shown on the
left side, and the files and subfolders within it are shown on the right.

Expands the folders.

Collapses the folders.

If the "Show Files" button is the only one selected, you can click this button
to move up one folder level.

3. Do one of the following:

n Locate and double-click the topic that you want to open.

OR

n Locate and click the topic you want to open. In the local toolbar, click .

The topic opens in its own page of the XML Editor.
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How to Open a Topic by Dragging
1. Open Windows and navigate to a folder containing a Flare project file.

2. Open the Content subfolder and locate the topic that you want to open.

3. Launch Flare Desktop.

4. Drag the topic file from Windows to the application window and drop it on the title bar in Flare
Desktop.

NOTE You can also use this method to open any file type that is supported in Flare
Desktop.
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Previewing Topics
Supported In:

You can quickly see how a topic (as well as a snippet or template page) will look in the final output
by previewing it. The Preview window pane is dynamic, allowing you to keep the preview open while
you work and see changes as you make them in the XML Editor.

You can preview the topic based on the output format used in any of the targets in your project
(including conditions that are set for that target). You can also preview a file based on specific
conditional expressions that you choose.

The Preview window pane updates when:

n A content file (i.e., topic, snippet, template page) is opened.

n A change is saved in the XML Editor.

n The refresh button in the window pane is clicked.

n The File, Target, or Conditional Expression fields in the window pane are updated.
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How to Preview Topics
1. Do one of the following, depending on the part of the user interface you are using:

n Local Toolbar Open a topic, snippet, or template page. Then in the local toolbar of the
XML Editor, click . If you click the down arrow, you can choose a target; otherwise,
the preview opens according to the settings in the primary target (e.g., with the
appropriate conditions already applied).

n Ribbon Open a topic, snippet, or template page. Then open the View ribbon and select
Preview Window. Like the button in the local toolbar, this option also has a down arrow
from which you can choose a specific target.

n Right-Click To preview a topic, snippet, or template page that is not open, you can right-
click the file in the Content Explorer and choose Preview.

The Preview window opens using settings for the target you selected.
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2. (Optional) By default, the Preview window pane will be floating. If you want to dock it to the
interface, click the title bar and drag it over a region identified by different squares. Then drop
the window pane on the appropriate square.

3. (Optional) You can continue editing the file. As you save your changes, the preview will
automatically update.

4. (Optional) You can adjust the preview in any of the following ways.

TO PREVIEW A SPECIFIC FILE

If you want to preview a different file from the current one, next to the File field click and
select the topic, snippet, or template page you want to preview. The file opens in the Preview
window pane.

TO CHANGE THE TARGET

From the Target drop-down, select the target you want to use for the preview. When you
select a target, the current preview changes accordingly, showing the content using the
condition tag settings in that target.
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TO CHANGE THE CONDITIONS

When you preview for a specific target, the condition tags set for that target are automatically
used in the preview. However, you can also preview your content by manually setting different
condition tags to be included or excluded. Flare Desktop will remember the manual condition
settings as you open one content file after another so that you do not need to select the
conditions each time you move to a different file.

a. Next to the Conditional Expression field, click . The Conditional Text dialog opens.

NOTE When you open the dialog, either the Basic or Advanced mode is already
selected, depending on which mode is being used in the target. For more
information about the Basic and Advanced modes, see the Help system.

b. If using the Basic mode, highlight a condition row, and select an option to the right
(Include, Exclude, Display by Media Query—Web, Tablet, or Mobile). Conditions already
provided in the target are set by default.

NOTE Changes in the Preview window are not transferred to the target
settings. They're simply temporary so that you can see what a topic looks like
with certain condition settings.

c. Click OK.

5. (Optional) Click in the local toolbar to refresh the Preview window. This ensures you are
seeing the most up-to-date content.
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6. (Optional) Click to lock the Preview window. By enabling the lock button, you can continue
to show the preview for one topic while opening other topics in the XML Editor.

7. Click the X in the top-right corner of the Preview window pane to close it.

CHAPTER 3  44



EXAMPLE You are working on a topic and want to use the Preview window to see how the
topic will appear using different settings in your project.

When you first open the Preview window, the preview looks as follows, with the primary
target settings applied:
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Now you want to see how the topic will look when you build the User-Guide-A PDF target.
From the Target drop-down, you select User-Guide-A. The preview changes to reflect the
new settings.
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Next, you want to see what would happen if you excluded the “Advanced-Info” condition in
that PDF target. You click the Conditions button and make your changes in the
Conditional Text dialog.
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After you click OK, the preview settings change, and the content associated with
“Advanced-Info” is excluded.

CHAPTER 3  49



Finally, you want to preview a different topic than the one currently open in the XML Editor,
so you select that topic in the File field. The new topic opens in the Preview window pane.

NOTE The preview feature is useful because it is a quick way to see how a content file
looks in the output. However, there may be times when you need to generate the entire
target and test the output. For example, you might want to see how topics look when
integrated with template pages or tables of contents.
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Analyzing Topics
See the following for information about analyzing topics:

Viewing Broken Bookmarks
You can view a list of files with broken bookmarks, including the bookmark destination that the link
is trying to find, the link text, the link tag, and other information. Also, you can open the file where
the broken link is located so that you can fix it. 
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How to View and Fix Broken Bookmarks
1. Open a content file (e.g., topic).

2. Select Analysis > Links > Broken Bookmarks.

The Broken Bookmarks window pane opens. The area at the bottom of the window pane
displays all files that contain bookmark links to the open file that are broken.

3. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n File Displays the name of the file where the broken link occurs.

n Folder Displays the folder where the file is found.

n Link Displays the link that is broken (e.g., the path and name of the topic in question).

n Type Displays the type of broken link (e.g., missing file).

n Link Text Displays the text in the source topic that is being used as the link.

n Link Tag Displays the style used for the link. For example, if a regular text hyperlink is
used, you will see "a" in this column.

n Extension Displays the file extension that the link is not finding (e.g., .htm, .jpg).

4. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

5. Double-click the row that you want to correct. The file opens in the appropriate editor or
dialog. For example, if the link appears in a topic, the XML Editor opens with the broken link
highlighted.

6. Redirect the link as necessary (e.g., right-click on the link and select Edit Hyperlink or Edit
Cross-Reference).
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Viewing Broken Links
You can view a list of files in your project where a broken link is located, including which file it is
trying to find, the link text, the link tag, and other information. Also, you can open the file where the
broken link is located. The broken link is highlighted so that you can easily fix it. 

How to View and Fix Broken Links
1. From the Analysis ribbon, click the Summary button.

2. If you see a row indicating broken links in red, double-click it.

3. In the grid listing all broken links, double-click one.

4. In the file that opens, the broken link is highlighted.

5. Edit the broken link or remove it.

6. Click to save your work.
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How to Fix Links Directly in the Broken Links Window
Pane

1. In the Broken Links window pane, click the row that you want to correct, then click . The Fix
Broken Links dialog opens.

2. In the Fix Broken Links dialog, do one of the following.

n Click or right-click a file and from the context menu, select Select file for linking. This
option opens a dialog, from which you can select a new link.

n Click or right-click a file and from the context menu, select Scan for Potential Links.
This option scans the project for potential matches to the broken link. When this option
is selected, the Search for Similar Files dialog opens, which lists the similar files that
the analysis tool has found. You can then select a file from that list.

The name of the file you select to fix the broken link will be displayed in the File field at the
bottom of the Fix Broken Links dialog.

3. Click Apply.
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Viewing Topics Not in a TOC
You can view a list of all topics that have been created in the project, but they have not yet been
linked to any items in a TOC. A drop-down filter lets you select a specific TOC to analyze, or you can
select "Any TOC" to analyze all TOCs in a project. 

How to View Topics Not Added to the TOC
1. Select Analysis > More Reports > Topics Not In Selected TOC.

The Topics Not In Selected TOC window pane opens. The area at the bottom of the window
pane displays all topics that have not yet been added to a TOC.

2. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n File Displays the name of the file.

n Title Displays the properties title of the file (if any).

n Folder Displays the folder where the file is found.

3. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

4. (Optional) You can drag topics from the Topics Not In Selected TOC window pane into an
open TOC by selecting a TOC from the Filter field in the Topics Not in Selected TOC window
pane, then dragging topics from the pane into the TOC. You may need to float and position
the TOC so you can see both it and the Topics Not in Selected TOC window pane.

NOTE You can open any file in the list to view or modify it in an editor. You can either
double-click on the specific row, or right-click on the row and select Open.
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Viewing Topics Not Indexed
You can view a list of all topics where you have not yet inserted index keywords. Therefore, no
references to those topics will be found in the generated index. You can also double-click a row to
open the topic in question. 

How to View Topics Not Indexed
1. Select Analysis > More Reports > Topics Not In Index.

The Topics Not In Index window pane opens. The area at the bottom of the window pane
displays all topics where you have not yet inserted index keywords.

2. To see more of the information in the window pane, drag the divider bar to make the pane
wider.

n File Displays the name of the file.

n Title Displays the properties title of the file (if any).

n Folder Displays the folder where the file is found.

3. If a certain number of items have been found, page navigation buttons in the local toolbar
may be enabled. You can use these buttons to go to additional pages to display more items.
You can also click View All in the local toolbar to see all results on a single page. Keep in mind
that the more items you have in the project, the longer it will take to load this view.

NOTE You can open any file in the list to view or modify it in an editor. You can either
double-click on the specific row, or right-click on the row and select Open.
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Reviewing Topics
See the following for information about topic reviews.

Sending Files for Review in Contributor or Flare
Desktop
Following are steps for sending files to others for review using Flare Desktop or Contributor (i.e., the
review package process).

How to Send Files for Review
1. Do one of the following:

n Open a file (topic or snippet).

n In the Content Explorer, select a file (topic or snippet).

n In the File List window pane (View > File List), select one or more files (topic or snippet).
You can hold the SHIFT key to select a range, or you can hold the CTRL key to select
individual items.

n Open a table of contents (TOC) or browse sequence and select one or more entries
within it. You can hold the SHIFT key to select a range, or you can hold the CTRL key to
select individual items.

NOTE If you use the TOC option, individuals who receive the review package
can view that package as a TOC using the TOC view option in the Review
Packages window pane. This allows them to see the context and organization
of the material that you send.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Review > Send for Review.

n Right-Click If you have a TOC or browse sequence open, right-click the entry and from
the context menu, select Send for Review.
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The Send Files for Review Wizard opens.

3. In the Review Package Name field, enter a name, and optionally add a description for the
package.

4. (Optional) If you want to add more files to the package file, do the following:
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a. Click .

b. Use the multi-view buttons to find the file(s) you want to add. If you want to add
multiple files, make sure is selected.

Option Description

Shows or hides the folders that the files are stored in.

Shows or hides the files. If you click this button when the Show
Folders button is selected, the area splits into two halves. The
folder is shown on the left side, and the files and subfolders within it
are shown on the right.

Shows or hides hidden files and folders.

If the Show Files button is the only one selected, you can click this
button to move up one folder level.

c. Find and select the file(s) you want to add to the package file. You can hold the SHIFT
key to select a range, or you can hold the CTRL key to select individual items. When you
are finished click Open in the dialog.

If you selected a topic that contains snippets, those snippets are also automatically added to
the package.

5. (Optional) The TOC drop-down defaults to (none). To associate files within a review package
to a TOC in the project, select a TOC.

6. Click Next.

7. Select Send to MadCap Contributor.
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8. (Optional) If you have overridden any default variable definitions for a particular target, and
you want the reviewer to see that definition rather than the default one, click in the drop-down
field and select it.

EXAMPLE You have a variable called "UserGuideTitle," and your default definition for
it in the Variable Set Editor is "User Guide A."
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However, for some targets, you override that definition in the Target Editor so that it
becomes "User Guide B."
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Suppose you send a topic for review that has the variable inserted into it, and you
keep the default variable selection in the Send Files for Review Wizard.

In that case, the reviewer sees the "User Guide A" variable definition.
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On the other hand, in the Send Files for Review Wizard if you select a target that uses
the alternate definition, the reviewer sees the "User Guide B" variable definition.

9. (Optional) If you want to include or exclude content in the review files based on condition
tags, do the following:

a. Click . The Conditional Text dialog opens.

b. You can include or exclude conditions in a couple of different ways, or even use both:

n Target Settings The easiest method is to click the Target Expressions drop-down
and select a target in your project. The dialog is automatically populated based
on the included and excluded conditions in that target.

n Manual You can also complete this dialog manually. You can use the same steps
that are used in the target for including and excluding certain condition tags. For
more information about the Basic and Advanced modes, see the Help system.
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c. When you are finished, click OK.

EXAMPLE You have a topic that looks like this, with four different conditions
applied to content:
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In the Conditional Text dialog accessed from the Send Files For Review Wizard,
you select Target Expressions and choose User-Guide-A.
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When the reviewer opens the file, this is what is shown:

10. (Optional) If you want to save a copy of the review package, click Save. Then find and select a
folder to store it in and click Save again. You might use this option, for example, if you want to
place the package in a network, SharePoint, or external resources folder where others can
access it, instead of using the built-in email method. If you use this feature, you do not need
to complete the rest of the steps. However, you do need to let the reviewer(s) know about the
review package, and the reviewers will need to let you know when they are finished making
changes to it.

11. (Optional) Click Next.
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12. (Optional) On the next page of the wizard, you can click in the Subject field and edit the
default text that will be shown in the Subject field of the email sent to the reviewers.

13. (Optional) Enter or select a message that will be shown in the main body of the email sent to
the reviewers.

n You can click in the Message area and edit or replace the default text.

OR

n You can select a saved message from the drop-down list above the Message field.

About the Saved Message Option The save option is useful if you repeatedly use the
same email message text when sending files for review. Instead of retyping the same
message each time you go through the wizard, you can click to type a new
message, and then you can save it. After the message is saved, you can select it from
the drop-down list above the Message field. If you want to rename an email message,
click .

14. (Optional) If you do not have an email address in the list, click . Complete
the fields in the New Address Book Entry dialog and click Add. Do this for each email
recipient.

15. (Optional) Once email addresses have been added to the list, click the Send check box next to
the addresses that you want to include in the email.

16. (Optional) Click Send. A message in Microsoft Outlook opens with the package file attached.

17. (Optional) Send the email.

NOTE There is more than one way to transfer files between individuals using Flare Desktop
and Contributor. For example, you can: (1) use the integrated email feature with Microsoft
Outlook, (2) add files to SharePoint or External Resources where others can access them,
or (3) save files to your computer (File > Save, then Save As or Save To) and then manually
transfer them using some method (e.g., email). If you want to use the integrated email
feature, you must have matching versions of Flare Desktop and Outlook. If you are using
64-bit Flare Desktop, you need 64-bit Outlook. Likewise, if you are using 32-bit Flare
Desktop, you need 32-bit Outlook.

NOTE If Microsoft Outlook is not installed or an Exchange server cannot be found, you will
be prompted to save the review file and send it manually.
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NOTE If you send out review packages and then move or rename the project, you will
receive an error stating that the package does not belong to the project when you attempt
to import those review packages. That's because Flare Desktop looks for the path of the
project. Therefore, in order for it to function correctly, you need to return the project to the
original path and name.

Viewing Reviewed Files in the Inbox
After an individual returns files that you have sent for review, you can bring those files into your
Flare project. Once a reviewed file is inside your project, you can view and accept it. If you do not
see any topics in the window pane, it might be because you did not use the built-in email feature,
but rather saved the review package manually. In that case, you need to import the review package.

How to View Reviewed Files
1. Select Review > File Reviews.

The File Reviews window pane opens.

2. From the drop-down at the top of the window pane, select Inbox. All reviewed files that you
have brought into your project, but have not yet been accepted, are listed in the pane.
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What’s Next?
From the File Reviews window pane, you can select a file in the list and click any of the following
buttons in the local toolbar to take action on it. This window pane can be used for either Flare
Online reviews or for Contributor reviews. Some of the options are available for only one process or
the other.

Item Description View Process

Lets you switch from viewing
“My” files to “All” files. In other
words, you can choose to see
only the files that you have added
to the review, or you can see all
files that you and other Flare
authors have selected for review.
This filter is applicable only to
Flare Online reviews; it is not
relevant to Contributor reviews.

Both Flare Online
Reviews

Refreshes the window pane so
that the latest information is
shown.

Both Both

Deletes the selection. Both Both

Opens a dialog asking if you want
to move the files to a closed
state. Select yes to close the file.
Select no to preview the file as a
read only file; edits can still occur
until it is accepted.

Both Both

Opens the source topic in the
XML Editor.

Inbox Both
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Item Description View Process

Lets you accept the reviewed file.
After accepting the file, it
overwrites the source file in your
project. Any edits or annotations
(i.e., comments) in the reviewed
file therefore become part of the
original file.

Inbox Both

Closes the review process for the
selected files. This action pertains
only to Flare Online reviews, not
to Contributor reviews. After a file
is closed for review, it means the
file can no longer be edited in
Flare Online. You can then accept
or reject any changes to the file in
the editor, then accept the file
back into the Flare project.

Both Flare Online
Reviews

Opens a dialog that lets you
import reviewed files into the
Inbox of the File Reviews window
pane. This option pertains to
Contributor reviews, not to Flare
Online reviews.

Inbox Contributor
Reviews
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Viewing Files Sent for Review
You can view a list of all files that you have sent to others for review. If you double-click a file from
the list in the File Reviews window pane, it opens in the XML Editor.

How to View Files Sent for Review
1. Select Review > File Reviews.

The File Reviews window pane opens.

2. From the drop-down at the top of the window pane, select Sent Files.

What’s Next?
From the File Reviews window pane, you can select a file in the list and click one of the buttons in
the local toolbar to take action on it. The options that you can use depend on whether you are using
Flare Online reviews or Contributor reviews.

CHAPTER 3  71



Accepting Reviewed Files
After an individual submits files that you have sent for review, those files populate the File Reviews
Inbox of your Flare project. You can close files, and then view and accept the files into the project.
Once all the assigned reviewers submit all the files for a review package, and those files are
accepted by the owner, the review package closes automatically. After accepting a file, it overwrites
the original source file in your project. Any edits or annotations in the reviewed file become part of
the source file.

How to Accept Reviewed Files
1. Select Review > File Reviews. The File Reviews window pane opens.

2. From the drop-down at the top of the window pane, select Inbox. It lists all the submitted files
from the review package, but the files have not yet been accepted.

NOTE If you are using Git branching, make sure the appropriate branch is active.
When closing the review process for files, dealing with tracked changes, and
accepting the file back into the project, you want to be working in the correct branch
so that the file changes are not applied in the incorrect branch.

In the File Reviews window pane, you can see which branch a file originates from.
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For Flare Online reviews, a file status should be Closed before it is accepted into the project.

Also, regardless of the process you use (Flare Online or Contributor), make sure you have
accepted or rejected the changes as necessary in the files.

3. In the grid, select the file(s) that you want to accept. You can hold the SHIFT key to select a
range, or you can hold the CTRL key to select individual items.

4. In the local toolbar, click .

A message opens (if there are unresolved changes), indicating that the unresolved changes
will be accepted if the file is accepted. However, if a conflict exists (e.g., the original file in
your project changed since the time you sent it out for review), a dialog opens to let you know
of the issue. You can then take the appropriate action; you can merge the changes from the
files, keep the edits from the reviewer (undoing your changes), or keep your edits (discarding
those from the reviewer).

5. Click OK. The reviewed file replaces the source file in the project.

Also, the file is removed from the File Reviews window pane.
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Merging Reviewed Files
If you attempt to accept a reviewed file and Flare Desktop detects a conflict, a dialog opens so that
you can take the appropriate action.

EXAMPLE You send a file to a reviewer. Before the reviewer returns the file, you make
changes to the original file in your project. Then you receive the reviewed file and attempt
to accept it so that it becomes part of your project. Flare Desktop detects a conflict
because the original has changed, so you are given a few options. You can merge the
changes from the files, keep the edits from the reviewer (undoing your changes), or keep
your edits (discarding those from the reviewer).
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How to Merge Reviewed Files
1. Go through the process of accepting a reviewed file (see "Accepting Reviewed Files" on page

72). If a conflict exists, a dialog opens.

2. In this dialog, you can choose from the following options and click OK.

n Merge changes in merge tool Opens a merging interface, which lets you see exactly
what changes were made and choose which to keep.

n Undo my local changes Removes your changes and keeps changes from the reviewer.

n Discard reviewer changes Removes changes from the reviewer and keeps your
changes.

If you selected the first option, the Merge Changes dialog opens, showing the original (local)
file on one side and the reviewed file on the other side, with changes shown in different
colors.

3. (Optional) If you want to change the colors associated with the changes, you can click
Options.

4. (Optional) By default the files are shown in a WYSIWYG (What You See Is What You Get) view.
But you can click Merge as Text to work in the markup instead; you can left-click to resolve
conflicts (accept changes) when merging as text.
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5. You can use the Merge Changes dialog to view and select changes. You can take actions in
the following ways.

n Right-Click Icon You can right-click on the icon next to a change on either the local or
reviewed side. This displays a context menu, which lets you keep or ignore a particular
change.

n Left-Click Icon You can left-click on the icon next to a change on either the local or
reviewed side. When you do this, the change from one side is kept and the change from
the other side is ignored. If you left-click the icon again, the results are toggled; the first
change is ignored and the other is kept.

n Type Content If you want to use your changes as well as those from the reviewer, and
even tweak the paragraph a bit more, you can click in the area at the bottom of the
dialog and simply type content.

n Previous/Next Conflict When you are finished resolving the first conflict, you can use
the "Previous Conflict" and "Next Conflict" buttons at the bottom of the dialog to work
on other conflicts in the topic.

6. After all conflicts have been resolved, click OK.

A backup of the original file is added to the Backups window pane. This lets you restore that
file if you do not want to keep the merged version.

Icons for File Differences
Following are descriptions of the various icons you might see in the Merge Changes dialog when
merging files.

Icon Description

Changed Content This indicates that the content has changed but there is no
conflict. Therefore, no action is needed.

Changed Tag This is the same as the "Changed Content" icon, except the content has
not changed, just a tag, such as a style or span.
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Icon Description

New Content This indicates that there is new content, but there is no conflict with
your changes. Therefore, no action is needed.

Deleted This indicates that content was deleted, but there is no conflict with your
changes. Therefore, no action is needed.

Following are descriptions of conflict icons.

Icon Description

Changed Content—Conflict This indicates that the content has changed and a
conflict exists. Therefore, user action is required. This icon appears in both the left
and right panes of the Merge Changes dialog at the spot of the conflict. You must
click on one of the icons to "Accept" that particular change.

Conflict Change—Accepted This indicates that a change with a conflict has been
accepted after clicking on . The bottom pane of the Merge Changes dialog
updates to show the accepted content.

Conflict Change—Not Accepted This indicates that a change with a conflict will not
be accepted. When you accept a conflict change and that side of the Merge Changes
dialog displays , the opposite pane where the conflict exists will display .

Changed Tag—Conflict This indicates that the tag has changed and a conflict exists.
Therefore, user action is required. This icon appears in both the left and right panes
of the Merge Changes dialog at the spot of the conflict. You must click on one of the
icons to "Accept" that particular change.

Conflict Tag—Accepted This indicates that a change with a conflict in a tag has been
accepted after clicking on . The bottom pane of the Merge Changes dialog
updates to show the accepted content.
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Icon Description

Conflict Tag—Not Accepted This indicates that a change with a conflict in a tag will
not be accepted. When you accept a conflict change and that side of the Merge
Changes dialog displays , the opposite pane where the conflict exists will display

.
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CHAPTER 4

Other Activities for Topics
In addition to the main activities, there are some other tasks you might perform regarding this
feature.

This chapter discusses the following:

Closing Topics 80

Creating New Topics From the TOC Editor 82

Deleting Topics 84

Setting the Default Paste Behavior 85

Pasting Text From Other Programs 86

Printing Topics 89

Renaming Topics 89

Including or Excluding Topics in Search 90

Specifying the Startup Topic in a Target 91

Print-Based Topics 92

Changing Topic Titles 102

XML Editor 105
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Closing Topics
You can have as many topics open as you want at one time. Each topic displays in its own page of
the XML Editor and remains accessible as you work. As you open more topics or other elements
(e.g., targets, tables of contents), each page displays in the appropriate editor (e.g., XML Editor,
Target Editor, TOC Editor).

You can close any single topic page that you want. You can also close all open topics (and other
open editors, such as targets and TOCs) at the same time. The steps below show you how to do
both.

How to Close a Single Topic
1. Click the X in the tab of the topic page.

NOTE If you have several elements open, you may need to click the ellipsis (…) or the
two down arrows to access the topic you want to close, which may be hidden from
view.

2. If the topic has an asterisk next to its file name, that means changes have been made to the
topic, but the changes have not yet been saved. If this happens, you will be asked if you want
to save your work to the file. If you do, click Yes. The topic is closed.

How to Close All Open Topics at the Same Time
1. Select Window > Close All Documents (face of the button). If you want to close all windows

except the one you have open, click the down arrow and select Close All But This.

2. If any elements, including topic pages, have an asterisk next to the file name, that means
changes have been made to the element, but the changes have not yet been saved. If this
happens, you will be asked if you want to save your work to the files. If you do, click Yes. The
topics are closed.
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What’s Noteworthy?

NOTE You can also set up Flare Desktop so that documents close automatically under
certain conditions. This can be done from the General tab in the Options dialog (File >
Options).
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Creating New Topics From the TOC
Editor

You can create topics at the same time that you create a table of contents (TOC). This method is
especially useful at the beginning of a project when you are first determining the structure of your
output.

How to Create a New Topic From the TOC Editor
1. Open your TOC.

2. Select the location in the TOC where you want to add the new topic.

EXAMPLE If you select a topic entry that already exists in the TOC, your new topic
will be placed directly after that existing topic.

3. In the local toolbar of the TOC Editor, click .

4. Complete the options in the Add File dialog.

a. In the Source area, choose to create the new file based on a template or an existing file.

n New From Template Choose either a factory template file or one of your own
custom template files as a starting point. The new file will take on all of the
settings contained in the template. If you want to use the factory template
provided by Flare Desktop, expand the Factory Templates folder and click on a
template file. If you want to use your own custom template file, expand the
appropriate folder and click on a file. For more information about templates, see
the Help system.

n New From Existing Choose an existing file of the same type as a starting point for
your new file. As with template files, your new file will take on all of the settings
contained in the file you select. To use this option, click , use the Open File
dialog to find a file, and double-click it.

b. (Optional) If you want to place the file into a subfolder previously created in the Content
Explorer or Project Organizer, in the Folder field click and select the subfolder.
Otherwise, keep the default location.

c. In the File Name field, type a new name for the topic.
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NOTE Spaces are allowed in the file name. However, if you are publishing
output to a UNIX system, avoiding spaces in the file name is recommended.
You can use underscores in place of spaces.

d. If you want the heading for the topic to use the same text that you provide for the file
name, leave the 1st Heading field blank. Otherwise, enter the text that you want to use
for the heading in the topic.

e. In the Title field, you can give the topic a title for the file. This does not refer to the
visual title (or heading) at the top of the topic. Rather, it refers to the properties title for
the topic.

If you leave this field blank, the text from the "1st Heading" field will automatically be
used for the title.

f. If you want the heading for the topic to use the default h1 style, leave the Style field
blank. Otherwise, select a style to apply to the heading in the topic.

g. In the Stylesheet field, select a stylesheet to associate with the new topic. If you do not
have a stylesheet in your project, this field remains blank.

5. Click Add. The topic is added to the Content Explorer and opens in its own page in the XML
Editor, and it is linked to a new entry (with the same name) in the TOC.

6. Now simply click inside the topic page and start typing text or adding any other elements
(e.g., tables, images, hyperlinks, multimedia) appropriate for the topic.

It is also likely that you will want to apply formatting styles to the topic at this point.

Also, you may want to adjust the placement of the TOC entry in the TOC Editor. Click the tab
for the TOC to return to the TOC Editor. If you want to adjust the position of the topic entry in
the TOC, select it and then use the arrow buttons in the local toolbar ( , , , ). You can
also drag and drop the topic entry to the location you want in the TOC.
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Deleting Topics
You can delete a topic any time you want. When you delete a topic, be aware of the following.

n If the topic contains any index keywords, those specific keywords will not be included in the
generated index.

n If other topics contain hyperlinks to the topic you are deleting, you are asked if you want to
keep or remove those links. However, even if you have the links removed, the text for the
hyperlink remains in the other topic.

How to Delete a Topic
1. Open the Content Explorer.

2. All of your topics are displayed under the Content folder (or under subfolders that you have
created previously when organizing your topics). Locate and select the topic that you want to
delete.

3. On your keyboard press DELETE.

4. You may be asked if you are certain you want to send the file to the recycle bin. If so, click
Yes.
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Setting the Default Paste Behavior
When you perform certain paste actions with tables or content from outside of Flare Desktop, a
paste icon appears in the editor. This icon lets you provide further information about how you want
to handle the content (e.g., convert tables to paragraphs, paste content as a list). There is always
more than one method that you can choose from when you click on the paste icon. And at the
bottom of every list of options is one to set the default behavior for similar actions in the future.

How to Set the Default Paste Behavior
1. Open a content file (e.g., topic, snippet) and perform one of the actions that causes the paste

icon to display.

n Converting Tables to Text

n Cutting Table Columns and Rows

n Merging Tables

n Pasting Cells Within a Table

2. Hover over the icon that appears after the content, click the drop-down arrow, and from the
menu select Set Default.

3. In the XML Editor of the Options dialog, select the paste method that you want to use as the
default for that type of action.

4. Click OK.

5. Click to save your work.

EXAMPLE You often paste content from Microsoft Word into your Flare documents. By
default, when you paste the content into a content file (e.g., topic, snippet), it comes in as
regular paragraphs, although you can select one of the other methods at that moment to
change it (e.g., paste as inline text, paste as paragraph block). Suppose that most of the
time you want the incoming text to be pasted into a list. In that case, after you paste some
content from Word, you can click on the paste icon and choose the option to set the
default. When you do this, a dialog opens, and you can select Paste List. Then, whenever
you paste content from an outside file in the future, that content will be brought in as a list
instead of a paragraph by default.
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Pasting Text From Other Programs
If you want to copy text from another program—such as Notepad, Microsoft Word, or a page in an
internet browser—you can paste it into Flare Desktop , and by clicking the paste icon next to
the copied content, you can specify how it should be brought into Flare Desktop.

How to Paste Text From Other Programs
1. After copying the text in the other program, open a content file (e.g., topic, snippet) in Flare

Desktop.

2. Place your cursor where you want to paste the text.

3. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Home > Paste.

n Right-Click Right-click and from the context menu select Paste.

n Keyboard Shortcut Press CTRL+V.

The content is pasted using the default behavior, and the paste icon appears after it. The
drop-down arrow is visible when you hover over the icon.

4. (Optional) If you want to change the way the content is added to the file, click the drop-down
arrow in the paste icon and select the option that best suits your needs.

n Paste Paragraphs Paste the text as regular paragraphs.

n Paste Paragraph Block Paste the text as paragraph blocks, such as <div>,
<blockquote>, or <fieldset>.

n Paste Inline Text Paste the text as inline text, so that it takes on the style of the location
where it is being pasted. If you have copied multiple lines of text from the source
document and use this option, the text will be pasted in one line, not multiple lines.

n Paste Table Paste the text into a new table.

n Paste List Paste the text as a new bulleted list.

n Paste HTML Paste text from an HTML source, such as a website.

n Set Default Open the XML Editor tab in the Options dialog, choose the type of behavior
you want to use automatically when performing this action in the future, and click OK.
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EXAMPLE You frequently copy text from Word documents into your Flare topics.
Normally you bring the text in as regular paragraphs, so you use that as the default
behavior.
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But suppose that in this case you want the content to be brought in as a list. In that
case, you simply click on the paste icon and select Paste List.

And here is the result.

5. Click to save your work.
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Printing Topics
You can print a topic shown in the Flare Desktop interface, whether it is a topic you are writing for
your own project or a topic you are viewing in the Help system.

How to Print a Topic
1. Open the topic.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select File > Print.

n Keyboard Shortcut Press CTRL+P.

3. In the Print dialog, complete the options and select OK.

NOTE At this time, it is possible to print only one topic at a time.

Renaming Topics
You can rename any of your topics in the Content Explorer.

How to Rename a Topic in the Content Explorer
1. Open the Content Explorer.

2. Click on the topic you want to rename.

3. Press F2 on your keyboard. The topic name (but not the file extension) is highlighted.

4. Type a new name for the topic and press ENTER.
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Including or Excluding Topics in
Search

Supported In:

You can include or exclude a topic when full-text search is generated. If you disable this feature, the
topic is excluded from the search, but it is still included in the generated output.

How to Include or Exclude Topics in Search
1. Open the Content Explorer.

2. Locate and click on the topic file.

3. In the local toolbar, click . The Properties dialog for the file opens.

4. Click the Topic Properties tab.

5. Click the check box labeled Include topic when full-text search database is generated.

6. Click OK.

NOTE In Microsoft HTML Help, all topics are always searchable.
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Specifying the Startup Topic in a
Target

Supported In:

You can specify which topic is the first one that users see when they open the online output. If you
have written a welcome or introduction topic, this would be a good "startup" topic to display first in
your output.

How to Specify the Startup Topic
1. Open the target.

2. On the General tab of the Target Editor, click the browse button next to the Startup Topic
field.

3. In the Link to Topic dialog, find and double-click the appropriate topic.

4. Click to save your work.
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Print-Based Topics
See the following for information about print-based topics:

Creating a Glossary Manually Using a Proxy
Supported In:

To produce a glossary manually for print output, you need to create a unique topic, insert a Glossary
proxy into it (Insert > Proxy > Insert Glossary Proxy), and drag that topic into the table of contents
(TOC) file (i.e., into the TOC Editor). You also do this to include a glossary in online output (instead
of, or in addition to, using a skin or search results to display glossary terms and definitions).
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Alternatively, you can let Flare Desktop auto-generate a glossary. For details, see the Help system.

The following explains how to use the manual method.
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How to Create a Glossary Manually Using a Proxy
1. Add a new topic as you normally would.

2. At the top of the topic, enter a title for your glossary. If you apply any of Flare Desktop's h1
through h6 styles to it, the glossary title will be displayed in the print TOC (if you create one).

3. Most likely, you will want to remove any text after the glossary title.

4. Select Insert > Proxy > Insert Glossary Proxy.

The Glossary Proxy dialog opens.

5. (Optional) If you want headings (e.g., A, B, C, D) to be added automatically at the top of each
section in the glossary, click the down arrow in the Generate Headings field and select Yes.
Otherwise, select No.

6. (Optional) From the Stylesheet class field, you can select a style for the glossary.

For example, you might create and use style classes if you want to generate multiple
glossaries with different looks for each output. Otherwise, the glossary will use the style
settings from the parent MadCap|glossaryProxy style. You can create a style class for this
purpose in the Stylesheet Editor. To do this, select the MadCap|glossaryProxy style and in the
local toolbar click Add Selector to create a class. The class will then be available from this
field in the Glossary Proxy dialog.

NOTE If you want to affect the look of the individual entries in the generated
glossary, you can also use the following in the Stylesheet Editor, which can be found
by expanding the parent div style: GlossaryPageDefinition, GlossaryPageEntry,
GlossaryPageHeading, and GlossaryPageTerm. For example, if you want to use blue
font for each term in the generated glossary, you can change the font color setting on
the div.GlossaryPageTerm style class.

7. Click OK. The proxy is added to the topic.

8. Click to save your work.
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Auto-Generate vs. Manual Proxies
The auto-generate method is much quicker and easier than the manual method. The manual
method is more flexible but requires you to perform a number of extra steps, such as creating
topics, inserting proxies, and adding files to the outline TOC. So if you simply want to quickly create
print output with generated TOCs, glossaries, or indexes, the auto-generate option might be best for
you. But if you want more control over the placement and look of the generated TOCs, glossaries,
and indexes, you should use the manual method.

NOTE ForAdobe PDF output, you can insert glossary-related Heading variables into page
layouts. These variables let you automatically display glossary headings and terms at the
top of pages.

Creating an Index Manually for Print
Supported In:

To create an index manually for print output, you need to create a unique topic and insert an Index
proxy into it. Alternatively, you can let Flare Desktop auto-generate one for you.

The following explains how to use the manual method.
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How to Create an Index Manually for Print
1. Add a new topic as you normally would.

2. At the top of the topic, enter a title for your index.

If you apply any of Flare Desktop's h1 through h6 styles to it, the index title will be displayed in
the print TOC (if you create one).

3. Most likely, you will want to remove any text after the index title.

4. Select Insert > Proxy > Insert Index Proxy.

The Index Proxy dialog opens.

5. Complete the options in the dialog.

n Generate Headings Select whether you want the printed index to include headings (e.g.,
A, B, C).

NOTE You can also edit this setting using your stylesheet. The default setting
is to always include index headings. But if you want headings to always be
excluded from indexes, you can modify the mc-index-heading property for the
MadCap|indexProxy style.

n Column Count Select the number of columns that you want to be used in Microsoft
Word output to display the index.

NOTE This option is for Word output only. If you are producing PDF output, you
can set the number of columns for an index in the page layout.

n (Optional) Stylesheet Class You can select a style class to associate with the proxy.

You might create and use style classes if you want to generate multiple indexes with
different looks for each output. Otherwise, the index will use the style settings from the
parent MadCap|indexProxy style. You can create a style class for this purpose in the
Stylesheet Editor. To do this, select the MadCap|indexProxy style and in the local
toolbar click Add Selector to create a class. The class will then be available from this
field in the Index Proxy dialog.
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NOTE If you want to affect the look of the individual entries in the generated
index, you can use the IndexHeading and the Index1 through Index9 styles
(classes of the p style) in the Stylesheet Editor. For example, if you want to use
blue font for the first-level entries in the generated index, you can change the
font color setting on the p.Index1 style.

6. Click OK. The proxy is added to the topic.

7. Click to save your work.

NOTE By default, if your index contains entries with multiple pages in a row, this will be
displayed as a range with the pages separated by a dash. For example, instead of showing
10, 11, 12, 13, the index entry will display 10-13.

NOTE For Adobe PDF output, you can insert index-related Heading variables into page
layouts. These variables let you automatically display index headings or terms at the top of
pages.

NOTE If you are using chapter or volume autonumbers and want them to be reflected in a
print index, you can do so by specifying the autonumbers at the appropriate locations in
your outline TOC (instead of inserting Chapter or Volume Number variables in a page
layout).
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Creating a TOC Manually for Print
Supported In:

To create a table of contents (TOC) manually for print output, you need to create a unique topic and
insert a TOC proxy into it. By default the print-based TOC is based on the h1 through h6 styles that
you have applied to content in your topics. The generated TOC in the print output is not necessarily
based on the structure of your "outline TOC” (i.e., the TOC file found in the Content Explorer), but the
outline TOC is used to determine the content to be included in the print-based output.
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How to Create a TOC Manually for Print
1. Add a TOC file (which serves as an outline in print-based output) and within it create entries

that link to topics.

2. Create a new topic.

3. At the top of the topic, enter a title (e.g., “Contents”) and remove unnecessary text after the
topic title. It is probably best not to use an h1 through h6 style for the heading since it will
then show up in the generated TOC.

NOTE However, it is possible to configure your stylesheet so that certain h1 through
h6 styles do not show up in the generated TOC. In the same way, it is possible to
create other styles besides h1 through h6 and configure them so that they do show
up in the generated TOC.

4. From the Insert ribbon, select Proxy > Insert TOC Proxy.
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5. (Optional) From the Stylesheet class field, you can select a style for the TOC.

For example, you might create and use style classes if you want to generate multiple TOCs
with different looks for each output. Otherwise, the generated TOC in the output will use the
style settings from the parent MadCap|tocProxy style. You can create a style class for this
purpose in the Stylesheet Editor. To do this, select the MadCap|tocProxy style and in the local
toolbar click Add Selector to create a class. The class will then be available from this field.

NOTE If you want to affect the look of the individual entries in the generated TOC,
you can use the TOC1 through TOC9 styles (classes of the p style) in the Stylesheet
Editor. For example, if you want to use blue font for the first-level headings in the
generated TOC, you can change the font color setting on the p.TOC1 style.

6. Click OK.

7. Click to save your work.

8. In the "outline" TOC file, add an entry near the top that links to the new topic containing the
TOC proxy.

NOTE Options in the Advanced tab of print-based targets let you automatically add
glossary, index, and TOC proxies to output. This means you do not need to create unique
topics and insert proxies into them manually. The auto-generate method is much quicker
and easier than the manual method. The manual method is more flexible but requires you
to perform a number of extra steps, such as creating topics, inserting proxies, and adding
files to the outline TOC. So if you simply want to quickly create print output with generated
TOCs, glossaries, or indexes, the auto-generate option might be best for you. But if you
want more control over the placement and look of the generated TOCs, glossaries, and
indexes, you should use the manual method.
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Changing Topic Titles
You can change the name of a topic title.

Where the Title is Used
This title is used in the following situations.

n Help Control Links The title displays as a selection when users click Help control links (i.e.,
related topics links, concept or "see also" links, and keyword links) that are associated with
that topic.

n Search Results When someone performs a search in online output, each result has a title to
identify it.

n TOC Entry If you drag the topic from the Content Explorer to the TOC Editor in Flare Desktop,
the label for that new entry automatically takes on the property title of the topic.

n Window Title Bar If the topic is opened in a new window or outside of the project, the title is
shown in the title bar of that window.

There is an order of precedence for which element is used:

1. Topic Title in Properties Dialog The title set in the Properties dialog has the highest level of
precedence.

2. Headings in Topic If there is no topic title specified in the Properties dialog, Flare Desktop
uses text associated with h1 through h6 heading styles.

3. File Name If there is no topic title or headings in a topic, Flare Desktop uses the topic file
name.
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How to Change the Title of a Topic
1. Open the Content Explorer.

2. Locate and click on the topic file.

3. In the local toolbar, click . The Properties dialog for the file opens.

4. Click the Topic Properties tab.

5. In the Topic Title field, you can enter a title. If you want to insert a variable in a field, you can
click . The variable will appear as syntax in the field, but in the output the variable definition
will be shown.

If you leave this field empty, it will automatically use the first heading text it finds in the topic.
Therefore, the title will be adjusted automatically if you later change the heading text in the
topic.

6. Click OK.
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Word Import—Use First Heading for Topic Title
You can use an automatic topic title option when importing Word documents (via the Import
Microsoft Word Wizard or Word Import Editor).

If this option is enabled, the properties setting for the topic title automatically uses the first heading
in the topic.

Therefore, if you later change the heading text in the topic, the title adjusts automatically as well.

If this option is disabled, the properties setting is based on that text as it existed at the time of the
import only, and it remains so unless you manually change it later.
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XML Editor
The XML Editor is used when you are editing topics.

Selecting a Page Layout to View Content in the
XML Editor
Flare Desktop provides multiple layout modes when working in the XML Editor: Web Layout, Web
Layout (Tablet), Web Layout (Mobile), and Print Layout. This lets you see your content in the format
that you are most likely concerned about at the moment.

The Print Layout mode lets you see how the pages will look with a page layout applied to it. In other
words, it lets you see how the page will look when you generate print-based output. This means that
you will be able to view the actual page size and orientation, as well as the margins and any header
or footer content.
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If you are viewing content using the Print Layout in the XML Editor, you can use another drop-down
in the local toolbar to choose a specific page layout.

Not only can you select a certain page layout to display a topic in the XML Editor, but you can also
choose a specific page type within that layout. This can be especially useful when you know for
certain that a particular topic will display on the first page of a chapter, a left page, a right page, etc.
The reason Flare Desktop does not automatically show a topic in the appropriate page type is
because it won't assign page types to content until you generate the output. However, sometimes
you may know in advance which page type will be used because of its placement in the outline TOC,
so you can choose any page type contained in the layout to display the topic in the XML Editor.
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EXAMPLE You have a project where you will be producing both online and PDF output
using the same topics. You open one of your topics and in the Web Layout view in the XML
Editor, it might look something like this.
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Now you want to see how it will look in the PDF output, so you switch to the Page Layout
view.

But just because the topic is being displayed in Print Layout view with print styles, this does
not mean the specific page layout intended for this topic in the output is being used here. In
this case, you notice that the XML Editor is using a page layout that is intended for your
PDF guide title page. This particular topic should be using your Chapters page layout
instead.
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To get a more accurate preview of how the topic will look in the output, you switch to the
page layout that will be used for chapters. You also select a specific page type.
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The result of your selection might make the topic look something like this:
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This particular view happens to be using the Left page type from your Chapters page
layout. But then you realize that this topic is actually going to be used at the very beginning
of a chapter. So you once again select the drop-down and choose the First page type.
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As a result, the view changes, showing the topic with the heading appearing part way down
the page, with no header. This is how you want the first page of a chapter to look, so you
know you're looking at the correct view.

CHAPTER 4  112



How to Select a Page Layout and Page Type to View
Content

1. Open the content file.

2. If the Print Layout mode is not already being used, click the down arrow next to Layout (Web)
in the local toolbar. From the drop-down, select Print Layout to switch to the Print Layout
view.

3. In the local toolbar, click the Page Layout drop-down and select a page layout. If you want to
select a particular page type included in that layout, select it from the submenu.

NOTE Because topics can end up anywhere in your output, based on your settings, Flare
Desktop won't know exactly how a particular page will look until you generate the output.
Once you generate the output, Flare Desktop takes all of the information that you've given it
in different places (e.g., Target Editor, outline TOC) and puts it all together according to
your rules.

NOTE You can get an even more accurate look at how a topic will look in the output by
associating conditions with it while you are editing. This is similar to the feature that you
can use to preview a document with certain conditions set. The difference is that this
associates the conditions to the document as you edit it in the XML Editor.
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Using the Zoom/Scale Feature
The bottom part of the XML Editor includes a toolbar that lets you use zoom/scale features to
better see your content. The features that are available depend on the layout mode you are working
in (e.g., Web Layout, Print Layout).

How to Use Zoom/Scale in Web Layout Mode
If you are using the Web Layout mode (including Tablet and Mobile), the following toolbar appears
at the bottom of the XML Editor:

You can use the zoom options in this toolbar to adjust the size of the text displayed in the XML
Editor.
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1. Make sure the topic is displayed in the XML Editor in one of the Web Layout modes. If it is
instead shown in Print Layout mode, click the down arrow next to to switch to
a Web Layout mode.
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2. In the toolbar at the bottom of the topic, click any of the available buttons to zoom in or out
on the font in the topic.

Option Description

Reduces the scale of the font by 10% each time you click the
button.

Resets the scale of the font to 100%.

Increases the scale of the font by 10% each time you click the
button.

Lets you select a specific percentage to scale the font. You can
also click the down arrow to select a preset zoom percentage.

How to Use Zoom/Scale in Print Layout Mode
If you are using the Print Layout mode, the following toolbar appears at the bottom of the XML
Editor:

First, you can use the buttons on the left side of this toolbar for navigating through a topic that is
long enough to consist of multiple pages. Second, you can use the Zoom/Scale button
to adjust the size and number of pages shown for the open topic. And third, you can use additional
zoom options to adjust the size of the text displayed in the XML Editor.
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1. Make sure the topic is displayed in the XML Editor in Print Layout mode. If it is instead shown
in a Web Layout mode, then click the down arrow next to in the local toolbar and
select Print Layout from the drop-down.
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2. In the toolbar at the bottom of the topic, click the Zoom/Scale button to adjust
the size and number of pages shown.

n 100% Displays the page at 100% of its actual size.

n 100% (2 pages) Shows two pages of a topic at a time, displaying each one at 100%.

n Fit Width Resizes the page so that it displays in proportion to the width of the window
pane.

n One Page Displays only one page at a time.

n Two Pages Displays two pages at a time.

n Four Pages Displays three pages at a time.

n Eight Pages Displays four pages at a time.

3. Use the other features to zoom in or out on the font in the topic.

Option Description

Reduces the scale of the font by 10% each time you click the
button.

Increases the scale of the font by 10% each time you click the
button.

Lets you select a specific percentage to scale the font. You can
also click the down arrow to select a preset zoom percentage.

How to Use Mouse Wheel Zoom
In addition to the options in the bottom toolbar of the XML Editor, you can also use your mouse
wheel (or scroll wheel). To do this, hold down the CTRL key on your keyboard and move your mouse
wheel to zoom in and out on content.
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What’s Noteworthy?

NOTE If you have zoomed in or out on content, you can press CTRL+0 on your keyboard to
return the view to 100%.

NOTE When you zoom in or out on content, the font is scaled only so that you can more
easily see it in the editor. The actual font size is not adjusted for the output. Also, objects
such as images remain at their original scale; only the font increases or decreases in scale.
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APPENDIX

PDFs
The following PDFs are available for download from the Help system.

Tutorials
Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Getting Started Tutorial

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

MadCap Flare Online
Integration Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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